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Welcome

Apple Learning Series: 3-6 Curriculum provides you with materials that help you

easily integrate technology into your classroom. This Getting Started Guide describes

the contents of 3-6 Curriculum, what you need to do before you use the software,

and how to install and begin using the software.

3-6 Curriculum includes the following items:

m The 3-6 Curriculum CD software case

m The 3-6 Curriculum Web site

m Quick Start card

3-6 Curriculum CD software case

The CD software case contains all of the software for 3-6 Curriculum. Most products

include electronic documentation on the CD, such as user’s manuals or teacher’s

guides.

Web site contents

The 3-6 Curriculum Web site includes the following components:

Curriculum

The Web site includes 12 student projects designed for the elementary school

classroom. Each project provides ideas for integrating the 3-6 Curriculum software 

in your classroom. You can view the student projects online or print them from the

Web site.

Read the Curriculum Overview on the Web site for detailed information about the

contents and structure of the student projects and the other curriculum resources.
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Step-by-step instructions

Step-by-step instructions for tasks that involve using the 3-6 Curriculum software and

Apple technology are included on the Web site. These detailed instructions are

designed to help your students work independently to complete software-related

activities. You can download and print the files. You need the Acrobat Reader

program installed on your computer to view and print the Step-by-Step Cards. After

you print them, you can laminate them for durability and keep them near the

computer.

Resources

Electronic templates are provided to help you and your students complete some of

the activities in the projects. You can use these files as is or customize them for your

classroom needs. These templates can be downloaded from the Web site. The

Resources area of the Web site also includes relevant QuickTime movies and

documents that can help you use the templates and projects.

From the 3-6 Curriculum Web site, you can also access the Web Page Construction

Site, a collection of instructions and other resources to help you create your own

Web pages. You can download this site and use it as a template for customizing your

own instructional Web site. You can then post it on an intranet or use it in your

classroom.

Curriculum standards

The 3-6 Curriculum Web site includes correlations information that shows how the

software and student projects align to curriculum standards. You can search for

correlation information by grade level, subject area, topic, and by select states.

Apple Learning Professional Development online course

3-6 Curriculum includes an online course that is designed to help you learn how to

use the kit software to enhance the curriculum in your classroom. You access this

course from the 3-6 Curriculum Web site by clicking the Professional Development

button.

The course introduces each of the software titles, presents a brief demonstration of

an aspect of the software, and describes how the software can be applied in your

classroom.

Community

This area of the Web site includes forums where you can discuss the 3-6 Curriculum

kit and its online course, student projects using the kit software that have been

submitted by other teachers, and teachers’ reviews of the software. You can also

access the extensive resources of Apple Learning Interchange (ALI), the Apple online

community for educators. ALI offers forums, chat rooms, lesson plans submitted by

teachers, special events, and other resources.
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First Steps

Several preliminary steps should be taken before you begin using the software in 

3-6 Curriculum. These steps are described in “Before You Use the Software,” below.

You should also become familiar with Adobe™ Acrobat™ Reader, the program you will

use to read most of the electronic documentation in this kit and to read the files you

download from the 3-6 Curriculum Web site. See “Using Acrobat Reader,” later in this

section, for detailed instructions about using this program.

Before you use the software

Before you begin to use the software in this kit, you need to select a printer, make

sure you have the latest version of QuickTime installed, and make sure that Acrobat

Reader is installed.

Note:  If you are using the student projects with an iBook or Power Mac G4

computer, you will need a compatible external microphone (available separately) to

complete the activities that involve recording sound.

Select a printer

Some programs in the kit require you to have a printer selected, even if your

computer is not connected to a printer. If you have not already selected a printer,

follow these steps to do so:

1 Open the Apple (K) menu and choose Chooser.

2 In the upper-left section of the Chooser window, click to select the printer driver 

that corresponds to the kind of printer you want to use.

Note:  If your computer is not connected to a printer, select the LaserWriter 8 icon,

then click the close box to close the Chooser. You don’t have to do steps 3 and 4.

3 In the upper-right section of the window, do one of the following:

m If you are connected to a network, click to select the name of the printer you 

want to print to.

m If you are not connected to a network, click to select the printer port or modem

port, whichever port your printer is connected to.
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4 Click the close box to close the Chooser window.

For more information on setting printer options, see the manual that came with your

printer.

Installing QuickTime

To use some of the software in the kit, you need QuickTime 4.0 or later installed on

your computer. To install the latest version of QuickTime, go to the Apple Web site at

www.apple.com/quicktime/ and follow the onscreen instructions. To check the

version of QuickTime that is installed on your computer, choose Control Panels from

the Apple menu, then choose Extensions Manager from the submenu. Scroll to

QuickTime in the list below Extensions. The version number is displayed.

Installing Acrobat Reader

Most of the electronic documentation included on the software CDs and the files you

download from the 3-6 Curriculum Web pages are in Adobe Acrobat format, also

called “PDF” format. To view and print these files, you need the Adobe Acrobat

Reader program. In some versions of the system software, Acrobat Reader is

preinstalled on your computer in the Applications folder.

If you purchased 3-6 Curriculum without a computer, you need to check to see if the

latest version of Acrobat Reader is installed on your computer. You can find out the

version number of the Acrobat Reader program installed on your computer by

selecting the Acrobat Reader program icon, then choosing Get Info from the File

menu. The version number is displayed. You can find out the latest version number

by going to the Adobe Systems, Inc. Web site at www.adobe.com. If the latest version

is not already installed, you can download the new Installer program for free from the

Adobe Web site.

Using Acrobat Reader

With Acrobat Reader, you can easily move around the documentation, search for

specific words or phrases, change the size of a page, and print any pages you want to

have as hard copy.

Moving through a document

You can move through a document in a number of different ways:

m To go to the next page, click the Next Page button ( ) on the toolbar.

m To return to the previous page, click the Previous Page button ( ) on the

toolbar.

m To return to the first page, click the First Page button ( ) on the toolbar.

m To go to a specific page, click the page number box on the status bar at the

bottom of the main window, type the page number, and click OK.

m To search for a specific word, phrase, or activity, click the binoculars button ( )

on the toolbar, type the information you are searching for, and click Find.
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For more information about moving around in Acrobat Reader documents, see

“Navigating pages,” in the “Viewing PDF documents” section of the Acrobat Reader

electronic help system.

Changing the size of a page

To magnify or reduce the size of a page, click the box with the magnifying glass ( )

on the status bar at the bottom of the page, then select a magnification level. Refer to

“Viewing documents” in the “Viewing PDF documents” section of the Acrobat Reader

electronic help system for detailed information on other page display tools and

options.

Printing pages

You can print any pages of a PDF document while in the Acrobat Reader program.

To print specific pages using most printers, follow these steps:

1 Choose Print from the File menu.

2 Enter the page numbers as they appear at the bottom of the Acrobat Reader window.

These numbers may differ from the numbers that actually appear on the document

itself.

3 Click Print.

Using the Acrobat Reader electronic help system

For more information about using Acrobat Reader, see the program’s electronic help

system. To use the help system, choose Reader Online Guide from the Help menu,

then select the topic you want. Click “How to use this online guide” from the list at

the left of the main page to learn more about using the help system.
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Software Descriptions 
and Installation Instructions

The CD software case contains all of the software titles included with 3-6 Curriculum.

The following sections provide a brief description of each software product,

information on installing and opening the program, and ways to learn more about 

it. Use these instructions, rather than the instructions that may be in the product’s

electronic manual or Read Me file. For most of the software products, you’ll find a

technical support phone number. (The phone numbers listed in this section were

current at the time the guide was written. However, this information is subject to

change.)

Note:  Do not install any version of QuickTime or Acrobat Reader that might be

included on a product’s CD. The product CDs sometimes include older versions of

QuickTime or Acrobat Reader. If you install an older version of QuickTime, you may

have problems using the software; an older version of Acrobat Reader might prevent

you from opening electronic documentation or files you download from the 3-6

Curriculum Web site.

If you install an older version of QuickTime or Acrobat Reader by mistake, you can

easily reinstall the current version. To install the latest version of QuickTime, go to

the Apple Web site at www.apple.com/quicktime/ and follow the onscreen

instructions. (After installation, you should make sure that the older version of

QuickTime is no longer on your hard disk.) To install the latest version of Acrobat

Reader, go to the Adobe Systems, Inc. Web site at www.adobe.com and follow those

instructions.
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Carmen Sandiego Word Detective 
from The Learning Company

In Carmen Sandiego Word Detective, students solve word challenges to stop Carmen

from turning all words into gibberish. To solve some of the challenges, students

select adjacent letters to spell out words, spell words that are said aloud, and return

words and punctuation to their correct locations within a story. The program allows

teachers to create customized lists of spelling words and to track student progress.

Installing Carmen Sandiego Word Detective

1 Insert the Carmen Sandiego Word Detective CD into the computer’s 

CD-ROM drive.

2 Double-click the Carmen Word Detective CD icon, if necessary.

3 Double-click the Installer icon.

4 Follow the onscreen instructions to complete the installation.

Using Carmen Sandiego Word Detective

Before you use Carmen Sandiego Word Detective, make sure your monitor is set to

display 256 colors. To do so, follow these steps:

1 Choose Control Panels from the Apple menu, then open the Monitors control panel

(called the Monitors & Sound control panel in some versions of the system software).

2 Click the Colors button under Color Depth, then click 256.

3 Close the control panel window.

To open Carmen Sandiego Word Detective, follow these steps:

1 Make sure the CD is still in the CD-ROM drive.

2 Open the Carmen Word Detective folder on your hard disk.

3 Double-click the Carmen Sandiego Word Detective icon to open the program.

4 If you see a message stating that the program may run more slowly because virtual

memory is turned on, click “Don’t show this dialog next time,” then click Continue.

Learning more about Carmen Sandiego Word Detective

A user’s guide is included on the CD. 

The service and support telephone number for Carmen Sandiego Word Detective is 

800-723-6322.
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The Cruncher from Knowledge Adventure

The Cruncher teaches students how to use spreadsheets and graphs by having them

solve problems and apply mathematical concepts to real-life situations. The results

can be displayed with graphs and charts and annotated with sound effects and

animated illustrations. The Cruncher also includes a Show feature which explains,

step-by-step, how The Cruncher solves the specific formula; projects which allow

students to use The Cruncher to solve interesting, real-world problems; and tutorials.

Installing The Cruncher

1 Insert The Cruncher CD into the computer’s CD-ROM drive.

2 Double-click the Cruncher 2.0 CD icon, if necessary.

3 Double-click the Cruncher 2 Installer icon.

4 In the licensing agreement dialog box that appears, click Agree.

5 In the next dialog box, click Install.

6 When you see a message stating that installation was successful, click Quit.

You’ll still need the CD to use The Cruncher because not all of the files from the CD

have been installed on your computer.

Using The Cruncher

Before you use The Cruncher, you need to make sure virtual memory is turned on.

To do so, follow these steps:

1 Choose Control Panels from the Apple menu, then choose Memory from the

submenu.

2 Click On under Virtual Memory if it is not already selected.

3 Close the Memory window by clicking its close box.

4 If you turned on virtual memory, restart your computer by choosing Restart from the

Special menu.

To open The Cruncher, follow these steps:

1 Make sure the CD is still in the CD-ROM drive.

2 Open the Cruncher 2.0 folder on your hard disk, if it’s not already open.

3 Double-click the Cruncher 2.0 icon to open the program.

4 Click Yes if you see a message about changing your monitor to display 256 colors.
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Learning more about The Cruncher

The Cruncher includes a teacher’s guide located in the Documentation folder on the

CD. Double-click the Cruncher 2.0 TG.pdf icon to open the teacher’s guide.

The Cruncher also includes six electronic tutorials and an electronic help system.

To use the electronic tutorials, follow these steps:

1 Double-click the Cruncher 2.0 icon to open the program.

2 Click the Tutorials button in the main screen.

3 Click the name of a tutorial to see its description on the right.

4 Click Open to start the tutorial you’ve selected.

To use The Cruncher’s electronic help system, follow these steps:

1 Choose Cruncher Help from the Help menu.

2 In the help window, click a topic to see information on the subject.

3 When you’re done using the help system, click the help window’s close box.

The service and support telephone number for The Cruncher is 800-457-8357.
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A Field Trip to the Rainforest Deluxe 
from Sunburst Technology

With this program, students travel through the rainforests of South America, Africa,

and Southeast Asia, learning about the plants, animals, and people who live in these

areas, as well as the status of rainforest resources and current and future preservation

efforts. Students can consult the comprehensive Field Guide for more information on

these topics, take notes and add pictures using the program’s Journal feature, and

play a rainforest trivia game. 

Installing A Field Trip to the Rainforest Deluxe

1 Insert the A Field Trip to the Rainforest Deluxe CD into the computer’s 

CD-ROM drive.

2 Double-click the Rainforest Deluxe CD icon, if necessary.

3 Double-click the Installer icon.

4 Click Continue in the opening screen.

5 Click Install in the next dialog box.

6 Click Continue if you see a message about quitting all open applications.

7 When you see a message stating that installation was successful, click Quit.

You’ll still need the CD to use A Field Trip to the Rainforest Deluxe because not all of

the files from the CD have been installed on your computer.

Using A Field Trip to the Rainforest Deluxe

1 Make sure the CD is still in the CD-ROM drive.

2 Open the “Rainforest-Deluxe ƒ” folder on your hard disk.

3 Double-click the Rainforest-Deluxe icon to open the program. 

Learning more about A Field Trip to the Rainforest Deluxe

A Field Trip to the Rainforest Deluxe includes a teacher’s guide located on the CD.

Double-click the Rainforest Deluxe.PDF icon to open this document. The teacher’s

guide contains information about using the program.

A Field Trip to the Rainforest Deluxe also includes an electronic help system. Click

Tocarra the Toucan on the screen to see help information about your current

location.

The service and support telephone number for A Field Trip to the Rainforest Deluxe

is 800-338-3457, extension 2410.
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Imagination Express Destination: Time Trip, USA 
from Edmark

This program allows students to create interactive stories using scenes from six

different time periods: 1640, 1776, 1865, 1929, 1945, and Today. In their stories,

students can combine animated stickers of people and objects with text they enter 

on the screen, narration and other sounds that they record, and prerecorded sounds.

In addition to stories, students can use the program to create items such as postcards

and newspapers. The options available can be customized according to the needs of

the students.

Installing Destination: Time Trip, USA

1 Insert the Imagination Express Destination: Time Trip, USA CD into the computer’s

CD-ROM drive.

2 Double-click the Time Trip, USA CD icon, if necessary.

3 Double-click the Install I.E. & Time Trip, USA icon.

4 Click Agree in the software license screen.

5 Click Continue in the next screen.

6 Click Install in the dialog box that appears.

7 Click Install in the next dialog box to install the files on your hard disk.

8 In the Registration dialog box, follow the onscreen instructions to register

electronically. If you want to register by phone or by mail, click Quit and then OK in

the next dialog box.

Note:  Do not install the version of QuickTime that is included on the CD. A more

recent version of QuickTime is already installed on your computer.

You’ll still need the CD to use Imagination Express Destination: Time Trip, USA

because not all of the files from the CD have been installed on your computer.

Using Destination: Time Trip, USA

1 Make sure the CD is still in the CD-ROM drive.

2 Open the Imagination Express folder on your hard disk if it’s not already open.

3 Double-click the Imagination Express icon to open the program.

4 Click Add Name. The first time you use an Imagination Express CD, you need to 

add your user name.

5 Type your name and click Add.

Learning more about Destination: Time Trip, USA

A teacher’s guide for the program is located on the CD. The teacher’s guide includes

user instructions and classroom activities. Double-click the Time Trip.PDF icon to

open the teacher’s guide.

The service and support telephone number for Imagination Express Destination:

Time Trip, USA is 800-528-7158.
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Mapmaker’s Toolkit from Tom Snyder Productions

Mapmaker’s Toolkit is a versatile program for creating maps to use in the classroom.

The CD includes more than 450 current and historical maps which can be used as

they are or customized to change the features displayed, add color and text, and

mark different elements such as transportation, population, crops, and weather. The

maps can be printed in different sizes (including as a poster), presented electronically

with the slideshow feature, or posted publically on the Internet. The program also

contains a stamp graphics library and a bookmark feature so students can quickly

return to frequently used maps.

Installing Mapmaker’s Toolkit

1 Insert the Mapmaker’s Toolkit CD into the computer’s CD-ROM drive.

2 Double-click the Mapmaker’s Toolkit CD icon, if necessary.

3 Double-click the Mapmaker Installer icon.

4 Click Continue in the opening screen.

5 Click Install in the next window.

6 Click Install in the dialog box that appears.

7 Click OK when you see a message stating that installation was successful.

You’ll still need the CD to use Mapmaker’s Toolkit because not all of the files from the

CD have been installed on your computer.

Using Mapmaker’s Toolkit

1 Make sure the CD is still in the CD-ROM drive.

2 Open the “Mapmaker’s Toolkit ƒ” folder on your hard disk, if it’s not 

already open.

3 Double-click the Mapmaker’s Toolkit icon to open the program.

4 Click Continue in the opening screen.

3-6 Curriculum Getting Started Guide 13



Learning more about Mapmaker’s Toolkit

Mapmaker’s Toolkit includes a teacher’s guide that provides a tutorial, user

information, classroom activities, and a curriculum guide. It’s a good idea to start 

by taking the tutorial, called a “walkthrough.” The file for the teacher’s guide is on 

the Mapmaker’s Toolkit CD.

Mapmaker’s Toolkit also includes an electronic help system. To use the help system,

follow these steps:

1 Choose Help Contents from the Help menu.

2 Click Topics, Index, or Look For to find information on the subject you want.

3 When you’re done viewing the help information for a particular topic, click the

question mark in the small help window to return to the main help window or click

the small help window’s close box to return to the Mapmaker’s Toolkit program.

The service and support telephone number for Mapmaker’s Toolkit is 800-342-0236.
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Math Mysteries: Whole Numbers 
from Tom Snyder Productions

Part of the Math Mysteries series, this title includes two CDs, both of which invite

students to join the passengers and crew on a cruise ship to solve math word

problems. With the Whole Class CD, the teacher introduces specific math skills and

the students collaborate to identify the problems, collect information, and solve the

problems. Then on their own or in pairs, students use the Mystery CD to practice and

reinforce skills in solving word problems. The CDs cover basic operations and single

and multi-step problems. 

Using the Whole Class CD

1 Insert the Math Mysteries: Whole Numbers Whole Class CD into the computer’s 

CD-ROM drive.

2 Double-click the Math Mysteries CD icon, if necessary.

3 Double-click the “Whole Numbers for Class” icon to open the program.

4 Click Continue in the next screen.

Using the Mystery CD

1 Insert the Math Mysteries: Whole Numbers Mystery CD into the computer’s CD-ROM

drive.

2 Double-click the Math Mysteries CD icon, if necessary.

3 Double-click the Whole Numbers Mystery icon to open the program.

4 Click Continue in the opening screen.

5 Click New if this is the first time you are using the program, type your name, choose

a location in which to save your data, and click Save.

Learning more about Math Mysteries: Whole Numbers

A teacher’s guide that includes reproducible worksheets is included on the Whole

Numbers CD. It includes information about both CDs. 

Math Mysteries: Whole Numbers also includes an electronic help system.

1 Click the Help button at the bottom of the screen to activate the help system.

2 Move the pointer over onscreen elements to see help information about that

element.

3 Click the Help button again to turn off the help system.

The service and support telephone number for Math Mysteries: Whole Numbers is

800-342-0236.

3-6 Curriculum Getting Started Guide 15



Mighty Math Calculating Crew from Edmark

The “crew” in this innovative math program is comprised of four superheroes who

challenge students with math problems in multiplication, division, number lines,

fractions, money, and 3D geometry. Activities such as Superhero Superstore and 

Dr. Gee’s 3D Lab feature onscreen manipulatives to help students understand the

underlying math concepts. The difficulty level and activity topic can be adjusted 

with the program’s Grow Slides component.

Using Mighty Math Calculating Crew

You use Mighty Math Calculating Crew directly from the CD. To open the program,

follow these steps:

1 Insert the Mighty Math Calculating Crew CD into the computer’s CD-ROM drive.

2 Double-click the Crew CD icon, if necessary.

3 Double-click the Calculating Crew icon to open the program.

4 Type your name or select it from the list and click Go.

5 Click a superhero to select an activity.

Note:  Do not install the version of QuickTime that is included on the CD. The

current version of QuickTime is already installed on your computer.

Learning more about Mighty Math Calculating Crew

A teacher’s guide for Mighty Math Calculating Crew is located on the CD. The

teacher’s guide includes user instructions and classroom activities. Double-click the

Calculating Crew.pdf icon to open the teacher’s guide.

The service and support telephone number for Mighty Math Calculating Crew is 

800-528-7158.
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Thinkin’ Science Series: Zap! from Edmark

Students explore light, sound, and electricity in Zap!, part of the Thinkin’ Science

series of educational software. In this engaging CD, as they prepare to produce a

concert, students explore three learning environments: Laser Lab where they

experiment with light and color; the ElectroLoft where they experiment with circuit

building and repair; and the SoundWave Studio where they learn about sounds and

their waveforms.

Students learn more about the topics covered with the “Sci-Clopedia” and take their

own notes with the Notebook feature. The program’s Grow Slides feature lets

teachers set the topics to be covered and the level of difficulty.

Using Zap!

You use Zap! directly from the CD. To open the Zap! program, follow these steps:

1 Insert the Zap! CD into the computer’s CD-ROM drive.

2 Double-click the Zap! CD icon if necessary.

3 Double-click the Zap! icon to open the program.

4 Type or select your name and click OK.

Note:  The CD includes an icon named Zap! Optional Install. The files that are

installed with that Installer program are intended to speed up the performance of the

SoundWave Studio environment. If you want to improve the performance of

SoundWave Studio, you can install those files by double-clicking the Zap! Optional

Install icon and following the onscreen instructions.

Learning more about Zap!

A teacher’s guide for Zap! is located on the CD. The teacher’s guide includes user

instructions, suggestions for introducing the program to students, classroom

activities, and reproducible worksheets. Double-click the Zap! Guide.pdf icon to

open the teacher’s guide.

The service and support telephone number for Zap! is 800-528-7158.
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What’s the Big Idea, Ben Franklin? from Scholastic

Based on the award-winning book of the same name, this engaging and humor-filled

CD presents Ben Franklin in his different roles as writer, printer, scientist, inventor,

diplomat, and founding father. Students can either watch and hear each chapter in a

video format, or read and hear each chapter in a more detailed text format. Games

for each chapter help reinforce what students learn. The CD includes audiovisual

“side trips,” a glossary, and a Teacher’s Resource room with assignments, bulletin

boards with ideas for displaying student work, and challenges.

Using What’s the Big Idea, Ben Franklin?

You use What’s the Big Idea, Ben Franklin? directly from the CD. To use the program,

follow these steps:

1 Insert the What’s the Big Idea, Ben Franklin? CD into the computer’s CD-ROM drive.

2 Double-click the Franklin CD icon, if necessary.

3 Double-click the Mac Cube icon.

4 Click Start in the screen that appears. The program checks to make sure that your

Macintosh computer has the appropriate settings files installed and then the program

opens.

5 Click School Use in the dialog box that appears the first time you use the program.

6 Type your name and click Continue. The Welcome screen appears.

7 Click Begin to start using the program.

You make selections from the “learning cube” to access the different elements on the

CD.

Learning more about What’s the Big Idea, Ben Franklin?

Click Tour in the Welcome screen to see a narrated introductory slideshow about the

program.

A teacher’s guide with the filename Ben Franklin Cube Guide.pdf is included on the

CD.

What’s the Big Idea, Ben Franklin? also has an electronic help system. Click Help in

any screen to find out more about that screen. Click Done to close the Help window.

The service and support telephone number for What’s the Big Idea, Ben Franklin? is

800-946-0136.

18 3-6 Curriculum Getting Started Guide



World Book 2001 Edition from World Book, Inc.

This two-CD set combines the text and illustrations of the World Book Encyclopedia

with the impact of video, sound, animation, and Internet resources. Students can

easily access specific information with the program’s search tools and can then use

the highlighting and sticky notes features to keep track of what they find.

World Book 2001 Edition includes an atlas, a dictionary, a Homework Wizard to help

students with assignments such as reports and timelines, and Internet links to

additional resources and updated information. This edition also includes Surf the

Millennium, a collection of imaginary Web sites from the last 1,000 years.

Installing World Book 2001 Edition

1 Insert the World Book Disk 1 CD into the computer’s CD-ROM drive.

2 Double-click the WB2001 Disk CD icon, if necessary.

3 Double-click the World Book 2001 Installer icon.

4 Click Continue in the opening screen.

5 Click Continue in the Read Me screen. (Information is included here about using

World Book 2001 Edition with the Multiple Users environment.)

6 Click Install in the next dialog box.

7 Click Install in the next dialog box to install the program in a folder called “World

Book folder” on your hard disk.

8 Click OK when you see a message stating that installation was successful.

You’ll still need the CDs to use World Book Encyclopedia 2001 Edition because not all

the files from the CDs have been installed on your computer.

Using World Book 2001 Edition

1 Make sure World Book Disk 1 is still in the CD drive.

2 Open the folder called World Book folder on your hard disk, if it’s not already open.

3 Double-click the World Book icon to open the program.

4 Click Agree in the license agreement window that appears the first time you open the

program.

5 Make a selection from the main menu screen.
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Learning more about World Book 2001 Edition

A user’s guide is included on the CD. Double-click the World Book–Mac Users Guide

icon in the CD window to open this document.

World Book Encyclopedia also includes an electronic help system.

1 Choose Help Topics from the Help menu to open the help system.

2 Click Topics, Index, or Find to locate information on the subject you want.

3 When you’re done using the help system, click the help window close box.

The service and support telephone number is 888-732-6564.
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